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Software Guide│Simple Software 7

SIMPLE SOFTWARE
Simple is the name of the software that is used as an interface to operate the saw. This soft-
ware offers a wide range of features, some of which are listed below:

Compatibility with all major cut file formats
Flexible job optimisation
Multi-level user access
Multi-document interface
Manual editing and creation of members
Member printing management
Three different views to cut from
Statistics output

To begin using Simple, double-click on the desktop.

BASIC STEPS

Log in and out
Every user can have their own user account when operating the saw. This makes it pos-
sible to provide different levels of system access to personnel and enables the plant man-
ager to review productivity levels of staff. For more details, see User Management on
page 85.



Note: A user must be logged in to start cutting. The name of the currently logged in
user is displayed in the message bar located at the bottom centre of the main win-
dow and highlighted in red below (see page 33).

To log into Simple, do the following:

1. Click on the toolbar.
2. The following window pops up:

Select your user name from the drop-down list.

Note: For more details on how to edit
the user list, see Add/Edit a user on
page 86 and Remove a user on
page 88.

3. Enter your password.

Notes:
l The Password field is greyed out if the access level of the selected user is
below the password level set in the User Management window (see page
88).

l The password of any user can be changed by anyone with a supervisor or
engineer access level in the Edit User window (see page 86).

l Once logged-in, each user can change their own password in the Change
Password window (see page 89).

4. Click .

To log out of Simple, do one of the following:

Click on the toolbar.

Select Logout from the File drop-down menu.

Click on the toolbar to let another user log in.
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Open and close a file
The following file types can be loaded into Simple to run cutting sequences:

l Simple files (*.smp)
l Simple files version 2 (*.smp2)
l MiTek files (*.mme)
l TrusSource files (*.dat, *.*)
l Omni files (*.omn)
l Alpine files (*.trs)
l Max Customer Cutter files (*.ems)
l Omni XML files (*.xml)
l IMP files (*.imp)

To open a file, do the following:

1. Click on the toolbar, or select Open... from the File drop-down menu.
2. The following window pops up:

Browse for the file you wish to open.

3. Select the file and click , or just double-click it.

To close a file, close the corresponding file tab or select Close from the File drop-down
menu.

Any unsaved changes are lost.

Navigate multiple open files
Several job files can be open at the same time and managed in the same window. Each
job file is opened in a new job tab to the right of any existing tab(s). The job tabs are loc-

ated under the toolbar and look like this:

You can switch to any open job by clicking on its tab. Job tabs can be dragged around to
change the order or dragged out into a separate pane to display two files side by side.

Open and close a file 9



Notes:
l When the saw is not running, all jobs can be reordered to any order required.
When the saw is running, only jobs to the right of the current running job can be
reordered as they have not been run yet.

l When a cutting sequence is running, the current job tab is displayed with a
green background. If automatic Job Sequencing is enabled (see page 19), the
next job tab will be displayed with a yellow background.

l You can also switch to any open file by selecting the file you wish to view from
theWindow drop-down menu.
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Merge files
To merge several files into one single file, do the following:

1.Open one of the files you wish to merge (for more details, see Open and close a
file on page 9).
2. SelectMerge from the File drop-down menu.
3. The following window pops up:

Browse for the other file(s) you wish to merge.

Note: if there are more than one additional file to merge located in the same
folder, you can select several files by pressing and holding down either the
⇧ key for consecutive files or the Control key for non-consecutive files.

4. Select the file(s) and click .
The members contained in the selected file(s) are added to the current
member list.

Note: If Interleave Members is checked, the new members will be interleaved
(i.e. alternated) with the existing ones. If unchecked, they will simply be
added to the end of the member list.

5. Repeat steps 2 to 4 for files located in different folders, if any.
6. Save the merged file by doing one of the following:

To merge the files into the currently open file, click  on the toolbar, or select
Save from the File drop-down menu.
To merge the files into a new file, select Save As... from the File drop-down
menu (for more details, see Save a file on the next page).
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Save a file

Note: files can only be saved as Simple files version 2 (*.smp2).

To save the file displayed in the current tab, do the following:

1. Click on the toolbar, or select Save from the File drop-down menu.
If the file has already been saved, it will be overridden using the settings pre-
viously defined in the Save As window.

2. If the file is saved for the first time, the following window pops up:

Browse for the file destination.

3. In the File Name field, enter a name for the file.
4. Enable one, both or none of the following options:

Optimised: The current optimisation order will be preserved and embedded in
the file. No automatic optimisation will occur again upon loading the file.
However it will still be possible to modify the file or manually run a new optim-
isation.
Locked: The file and the embedded optimisation will be locked. It will never be
possible to modify the file or run an optimisation again, except through the Batch
Optimise feature (see page 51).

5. Click .

Note: to save a new copy or change the save settings of a file, select Save As...
from the File drop-down menu and proceed as above from step 2.
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ADD MATERIALS
The Add Materials window pops up each time an optimisation is run if required materials
are missing or disabled in the materials database (see page 47). It can occur either when
an unoptimised file is loaded or when an optimisation is run manually.

The list contains all the materials that are missing for a complete optimisation. For each
required material, you can do either of the following by double-clicking the Action field:

Create a newmaterial
Reassign it to an existing material
Pick a disabled material
Ignore it

Note: By default, the Actions field is set to "New" for each missing material, or
"Pick" for each disabled material. In the latter case, the shortest matching material
will be picked.

Click to exit the window and execute the decisions made for each material in
the list.

Newmaterial

If you select in the Actions field, a new material will be added to the materials data-
base for the corresponding required material.

The length, bin number, priority and cost of each new material can be edited in the relevant
fields.

AddMaterials 13



Note: the following rules apply:
l The length of the new material must be equal to or higher than the value spe-
cified in the Min Length field (by default, it is set to the nearest multiple of
300 mm above the minimum length).

l The priority must be "1" or above.

Reassign a material

If you select in the Actions field, a window lets you choose from a list of existing
materials that meet the minimum length requirement, regardless of their description, width,
thickness and whether enabled or not.

Note: the button is greyed out if the materials database does not contain any mater-
ial that meet the minimum length requirement.

If a chosen material needs to be re-enabled, its priority is automatically changed from "0" to
"1". The priority of each reassigned material can be changed to any value above "1".

Pick a material

If you select in the Actions field, a window lets you choose from a list of disabled
materials that perfectly match the description of the required material.

Note: A disabled material is a material with a priority set to "0".
The button is greyed out if the materials database does not contain any disabled
material that perfectly matches the description of the required material, or if the only
matching material has already been picked by default.

The chosen material is automatically re-enabled (its priority is changed from "0" to "1"). A
higher priority can be specified for each picked material.

Ignore materials

If you select in the Actions field and click , a message box will show the
number of members that could not be optimised. The Add Materials window will then pop
up again the next time an optimisation is run.

Note: you can click to quickly ignore all the missing or disabled mater-
ials and dismiss the window.
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MAINWINDOW

Toolbar

Note: to show or hide the toolbar, check or uncheck Toolbar in the View drop-down
menu.

The toolbar is available at the top of the main window. It gives quick access to the following
actions and settings:

Opens the Open window to load a file (see page 9).

Saves the file currently open in the active tab, or opens the Save As win-
dow (see page 12) if the file has never been saved before.

Opens the Login window (see page 7).

Logs out the current user.

Opens the standard print window to print the contents of the active tab
(Member List or Optimised).

Opens the Materials List window (see page 36).

Optimise All: runs the optimisation of all members in the Member List tab.

Note: if there are already some partially or completely cut mem-
bers (indicated by a quantity greater than "0" in the Done
column), a dialog box will pop up. Choose whether you want to
optimise all the members or only the uncut members.
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Optimise Selected: runs the optimisation of the members that have been
selected in the Member List tab.

Note: if there are already some partially or completely cut mem-
bers (indicated by a quantity greater than "0" in the Done
column), a dialog box will pop up. Choose whether you want to
optimise all the selected members or only the selected uncut
members.

Optimise On-the-fly Selected: commands the saw to cut the members
that have been selected in the Member List tab out of unknown lengths of
timber that can be randomly fed into the saw. This function is great for
consuming long and varying length offcuts.

Select the members you wish to cut, then click this button and press the
green START button on the operator console to start cutting. The saw
will dynamically measure each new length of timber that is fed, run an
optimisation process on the members remaining to be cut for that length
(much like normal optimisation) and proceed to cut all the members it can
out of that board with the least waste possible.

Notes:
l All the selected members must have the same width and thick-
ness for this function to operate. Same timber grade is also
recommended.

l If there are already some partially or completely cut members
(indicated by a quantity greater than "0" in the Done column),
a dialog box will pop up. Choose whether you want to optim-
ise on-the-fly all the selected members or only the selected
uncut members.

l The operator will be prompted to enter the number of the bunk
to pick the timbers from with the WoodRunner (if installed).

l If no members can be cut from the current measured stick,
Simple will display a warning, eject the stick and continue to
cut.
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Cut All Uncut: commands the saw to cut all uncut members in the active
tab (Member List or Optimised).
Click this button and then press the green START button on the operator
console to start cutting. As cutting progresses down the list, the saw will
skip over any members that have already been cut.

Note: Already cut members are indicated by a quantity greater
than "0" in the Done column of the Member List tab, or tagged
with an asterisk in the left-most column of the Optimised tab.
If a cutting sequence is launched from the Optimised tab, the cut
members will be updated in both tabs. If a cutting sequence is
launched from the Member List tab, the cut members will be
updated in this tab only.

Cut Selected Uncut: commands the saw to cut the uncut members that
have been selected in the active tab (Member List or Optimised), or any
member selected in the Member Tree tab.
Select the members you wish to cut, then click this button and press the
green START button on the operator console to start cutting.

Note: in the Optimised tab, all members in the same stick must
be selected for this function to work properly (i.e. the first selec-
ted member must be a stock material line and all members
included in that material must be selected).

Cut Remaining Uncut: commands the saw to cut the uncut members
from the member selected in the active tab (Member List or Optimised).
Select the member you wish to start from, then click this button and press
the green START button on the operator console to start cutting. The saw
will work its way down the list from this point.

Note: in the Optimised tab, the selected member must be the
only one or the first one in a stick for this function to work pro-
perly (i.e. it must be a stock material line).

Makes Simple stop sending commands to the saw.

Note: The saw will complete the execution of the last command
sent and will then stop. A new cutting sequence will have to be
sent to restart the saw.
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Set All To Uncut: sets to uncut status all members in the active tab
(Member List or Optimised).

Set Selected To Uncut: sets to uncut status the members that have
been selected in the active tab (Member List or Optimised).

(optional)

Indicates that the follower
is currently disabled.
Click to enable the fol-
lower.

(optional)

Indicates that the follower
is currently enabled.
Click to disable the fol-
lower.

Note: After turning the follower on or off, you need to wait for the
status display window to disappear then rehome the saw.

Indicates that the Long
Lead feature is currently dis-
abled.
Click to enable the Long
Lead feature.

Indicates that the Long
Lead feature is currently
enabled.
Click to disable the Long
Lead feature.

Note: The Long Lead feature moves all cuts 100 mm (default
value of variable P521) along the timber. This can be useful
when cutting a member from a piece of waste timber with a
non-square leading end.

(optional)

Indicates that the Automatic
Infeed Table is currently dis-
abled.
Click to enable the Auto-
matic Infeed Table.

(optional)

Indicates that the Auto-
matic Infeed Table is cur-
rently enabled.
Click to disable the Auto-
matic Infeed Table.

Indicates that long pieces
of waste (after all members
in the stick are cut) are cur-
rently sent to the outfeed.
Click to send long pieces of
waste back out to the
infeed.

Indicates that long pieces
of waste (after all members
in the stick are cut) are cur-
rently sent back out to the
infeed.
Click to send long pieces
of waste to the outfeed.
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Indicates that the automatic
Job Sequencing feature is
currently disabled.
Click to enable the auto-
matic Job Sequencing fea-
ture.

Indicates that the automatic
Job Sequencing feature is
currently enabled.
Click to disable the auto-
matic Job Sequencing fea-
ture.

Note: The Job Sequencing feature enables the saw to auto-
matically start cutting the optimised list in the job file tab to the
right of the current job file, when and only when the last member
in the optimised list of the current job file has been cut. With this
feature enabled, the current job file tab will be coloured in green
and the job file tab to be cut next will be coloured in yellow.
When the current job file is finished, a pop-up will notify the oper-
ator the new job file has started and the colour of the tabs will
also change automatically. The order of the non-active job file
tabs (yellow or grey) can be changed at any time during cutting
by clicking and dragging ahead or behind other tabs. The inact-
ive job files can even be re-optimised while cutting the active
one.
This feature will only work if the cutting sequence has been star-
ted in the first optimised list by using either the Cut All Uncut or
Cut Remaining Uncut function.

Opens the Options window (see page 37).

Opens Vekta Rescue in the web browser.

Multi-view Tabbed Pane
The multi-view tabbed pane is available on the middle left of the main window. It offers
three different views to browse, manage and cut members. An additional view is present if
the file contains layout information.
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Member List tab

The Member List tab shows all the members included in the file in their non-optimised state.

Note: the orange-highlighted lines identify the members that are impossible to cut
due to an out-of-range angle.

Sort members

Note: Sorting the members in the Member List tab will override the pre-optimisation
order (Pre-Optimisation list) defined in the Sorting tab of the Options window (see
page 43). To restore the pre-optimisation order, close and reopen the file.

You can sort the members by clicking any column header:

l Click a column header to sort the members in ascending order based on that column.
l Click the same column header again to sort the members in descending order.

The Member List tab contains the following columns:

Job: designation of the job the member belongs to
Truss: designation of the truss the member is part of
Member: designation of the member within the truss
Length: overall length of the member

Note: Any red value in this column means that an automatic length adjust-
ment has been applied to the member. For more details, see Automatic
Length Adjustment on page 96.

Type: type of the member
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Done: number of members already cut
Total: total number of members to be cut
Bin: bunk the timber is located in if an automated timber retrieval system is installed
Kickoff: kickoff location the member will be sent to (set in the job file or overridden by
the kickoff rules if any)

Note: A value of "-1" means that the kickoff location is undefined.

Material: description of the material assigned to the member

To hide or show specific columns, right-click any
column header and select Select Columns... from the
context menu. You can then check the columns you
want to show and uncheck the ones you want to hide.

Click  to confirm.

Select members

To select a single member, simply left-click on the desired member. This will highlight the
line in blue.

To select multiple members, do the following:

1. Left-click on any member you wish to select.
2. Hold down the Control key and left-click on any other members you wish to select.

To select a block of members, do the following:

1. Left-click on the first member of the block you wish to select.
2. Hold down the ⇧ key and left-click on the last member of the block. Both clicked
members and all the members in between will be selected. The entire block will be
highlighted in blue.

To select multiple blocks of members, do the following:

1. Select the first block as per the above procedure.
2. Hold down the Control key and left-click on the first member of the next block you
wish to select.
3. Hold down the Control and ⇧ keys together and left-click on the last member of
that block.
4. Repeat steps 2 & 3 for any other blocks you wish to select.

To exclude a member from any selection, hold down the Control key and left-click on the
member you wish to exclude.
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Note: if a single member is selected, it will remain selected when switching to
another tab (if present in the other tab).

Available functions

When the Member List tab is active, all the functions of the Toolbar are available (see page
15).

You can right-click on the selected member(s) to display a context menu. It includes short-
cuts to some functions of the Toolbar, and gives access to the following additional actions:

Set Quantity Cut...: opens the Edit Quantity
Cut window to change the number of mem-
bers already cut (Done column) out of the
total quantity required (Total column).
Edit/Add Member...: opens the Complete
Member Editing window to edit the selected
member (see page 77), or create a new mem-
ber in the list (see page 78).
Set Kickoff Location...: opens a keypad that
lets you choose another kickoff location for
the selected member(s).

Note: this will override any value set
in the job file or by the kickoff rules.

Reset Kickoff Location: restore the kickoff
location to its initial value.
Undo Auto Length Adjustment: resets the
length of the member to its nominal value
when an automatic length adjustment has
been applied (for more details, see Automatic Length Adjustment on page 96).
Cut Selected: commands the saw to cut the selected member(s) regardless of
whether they have already been cut or not.
Save Selected As...: opens the Save As... window to save the selected member(s) as
a new file (for more details, see Save a file on page 12).
Preview Image...: opens the Print Preview window (see page 70).
View 3D Model...: opens the 3D Model window (see page 83).
Flip Selected: turns the selected member(s) over width-wise.
Rotate Selected: turns the selected member(s) over length-wise.
Flip & Rotate Selected: rotates the selected member(s) by 180° in the horizontal
plane.
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Select Columns...: opens the Select Columns window that lets you choose the
columns to display.

Note:Most of these actions can be performed on either a single member or a mul-
tiple selection. Edit Member, Preview Image, 3D Model and
Undo Auto Length Adjustment can only be performed on a single member.

Member Tree tab

The Member Tree tab makes it easy to locate a specific member within the file. The tree
view shows a hierarchical list of the following elements:

job
truss
member
cut (different pictogram for each type of cut)

Double-click an element (cuts excepted) or click the button next to it to expand its con-
tents. Double-click the same element or click the button next to it to collapse its contents.

Any one of the elements present in the list can be selected at a time.

Note:When a cut is selected, it is shown in red on the Member Diagram (see page
28).
Any member selected in this tab will remain selected when switching to another
tab (if present in the other tab).

When the Member Tree tab is active, only the Optimise All and Cut Selected Uncut functions
of the Toolbar are available (see page 15).
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Click the Cut Selected Uncut button on the Toolbar to start cutting the entire selected ele-
ment (job, truss or member). This feature is of particular use when a specific element needs
to be recut.

Optimised tab

The Optimised tab shows the members that have been optimised. The timbers are listed in
the cutting order and each timber contains the member(s) it will be cut into.

Notes:
l The orange-highlighted lines identify the members that are impossible to cut
due to an out-of-range angle.

l The members displayed in light grey are either at the top of a vertical stack, or
away from the fenceline in the case of a horizontal stack.

l Already cut members are tagged with an asterisk (star) in the left-most column.

The Optimised tab contains the following columns:

Stack: indication on how timbers are stacked (If empty, no timbers are stacked.)

E X A M P L E S

"2xW" means that two timbers are stacked side by side.
"45/45" means that two 45-mm-thick timbers are stacked one on top of the
other.
"35/45" means that a 45-mm-thick timber is stacked above a 35-mm-thick tim-
ber.

Material: description of the material assigned to the member(s)
Length: length of the timber
Bin: bunk the timber is located in if an automated timber retrieval system is installed
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Job: designation of the job the member belongs to
Truss: designation of the truss the member is part of
Member: designation of the member within the truss
Type: type of the member
Length: overall length of the member

Note: Any red value in this column means that an automatic length adjust-
ment has been applied to the member. For more details, see Automatic
Length Adjustment on page 96.

Kickoff: kickoff location the member will be sent to (set in the job file or overridden by
the kickoff rules if any)

Note: A value of "-1" means that the kickoff location is undefined.

Waste: length of waste in the timber

Note: any red value in this column means that the waste length is equal to or
greater than the minimum reusable waste length that can be set in the Offcuts
tab of the Options window.

Left: number of alike timbers left to be fed

Note: alike timbers are adjacent to each other in the list and share the same
material description, material dimensions and stacking configuration.

To hide or show specific columns, right-click any
column header and select Select Columns... from the
context menu. You can then check the columns you
want to show and uncheck the ones you want to hide.

Click  to confirm.

Select members

To select a single member, simply left-click on the desired member. This will highlight the
line in blue.

To select multiple members, do the following:

1. Left-click on any member you wish to select.
2. Hold down the Control key and left-click on any other members you wish to select.
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To select a block of members, do the following:

1. Left-click on the first member of the block you wish to select.
2. Hold down the ⇧ key and left-click on the last member of the block. Both clicked
members and all the members in between will be selected. The entire block will be
highlighted in blue.

To select multiple blocks of members, do the following:

1. Select the first block as per the above procedure.
2. Hold down the Control key and left-click on the first member of the next block you
wish to select.
3. Hold down the Control and ⇧ keys together and left-click on the last member of
that block.
4. Repeat steps 2 & 3 for any other blocks you wish to select.

To exclude a member from any selection, hold down the Control key and left-click on the
member you wish to exclude.

Note: if a single member is selected, it will remain selected when switching to
another tab (if present in the other tab).

Available functions

When the Optimised tab is active, all the functions of the Toolbar, except Optimise Selected
and Optimise On-the-fly Selected, are available (see page 15).
You can right-click on the selected member(s) to display a context menu. It gives access to
the following actions:

Set Kickoff Location...: opens a keypad that lets
you choose another kickoff location for the selected
member(s).

Note: this will override any value set
in the job file or by the kickoff rules.

Reset Kickoff Location: restore the kickoff location
to its initial value.
Preview Image...: opens the Print Preview window (see page 70).
View 3D Model...: opens the 3D Model window (see page 83).
Select Columns...: opens the Select Columns window that lets you choose the
columns to display.
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Layout tab

Note: this feature is only supported with the following file formats:
l Simple files version 2 (*.smp2)
l MiTek files (*.mme), if a relevant .mps file is present in the same folder
l Omni XML files (*.xml)

The Layout tab shows an overview of the truss that contains the last selected member. A
Print Preview of the selected member is displayed in the top part of the window instead of
the member diagram.

You can select another member on the truss, or switch to any other truss layout included in
the file using the drop-down list in the top left corner.

Note: any member selected in this tab will remain selected when switching to
another tab (if present in the other tab).

The following elements can be present on the truss layout:

Member

Selected member

Nail plate

Member included in the truss but not present in the file

Invalid member

Opening (doorway, window...)
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When the Layout tab is active, only the Optimise All function of the Toolbar is available (see
page 15).

Member Diagram
The member diagram is available at the top of the main window. It gives an accurate
description and top-view representation of the member currently being cut or selected in
the active tab (Member List,Member Tree or Optimised). The diagram also shows in red the
cut either in progress or currently selected in the Member Tree tab. For more details about
the different tabs, see Multi-view Tabbed Pane on page 19.

Colour legend and types of cuts
The top-view representation shows the different cuts performed on the timber to obtain the
desired member. The following colours and types of cuts can be present on the diagram:

Timber (material)

Member

Straight end cut

Bevel end cut on the top side of the member

Bevel end cut on the bottom side of the member

Trench cut on the top side of the member (optional)
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Trench cut on the bottom side of the member (optional)

Note: Trench cuts can be performed on the top side only. The
member needs to be flipped over for this cut to be performed.

Side trench cut (optional)

Undercut on the top side of the member

Note: Undercuts can be performed on the bottom side only. The
member needs to be flipped over for this cut to be performed.

Undercut on the bottom side of the member

Taper cut

Birdsmouth cut

Cut in progress or selected

Member details
The member diagram includes the following details:

Job: designation of the job the member belongs to
Truss: designation of the truss the member is part of
Member: designation of the member within the truss
(_ of _): member number out of the total quantity of the same member
Length (in mm): overall length of the member in the Member List and Member Tree
tabs, or length of the timber in the Optimised tab

Note: A red value means that an automatic length adjustment has been
applied to the member. For more details, see Automatic Length Adjustment
on page 96.

Material: description of the material assigned to the member
Top (in mm): length of the edge facing the back of the machine
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Centre (in mm): length through the centre line of the member
Bottom (in mm): length of the edge facing the door

(in mm): overall length of the member

Note: A red value means that an automatic length adjustment has been
applied to the member. The nominal length is indicated in parentheses. For
more details, see Automatic Length Adjustment on page 96.

(in mm): overall width of the member

Cut parameters
The following parameters can be visible under the corresponding end cut:

0 mm (X-axis): location of the cut along the timber from the right end of the member
with the negative values to the left (if the infeed direction is from the left to the right)
C (C-axis, in degrees): angle of the cut measured counter-clockwise relative to the
X-axis

E X A M P L E
A value of "90°" or "-90°" will result in a square cut (if there is no bevel angle).

CO (Y-axis, in mm): horizontal offset of the cut angle from the edge facing the back of
the machine with the positive values towards the door
B (B-axis, in degrees): bevel angle measured clockwise from the vertical
BO (Z-axis, in mm): vertical offset of the bevel angle from the bottom side of the mem-
ber with the positive values upwards

Control Bar
The control bar is available at the bottom of the main window. It is broken into various sec-
tions, each of which performs different functions. It can be used to operate and adjust the
saw manually, set up the printer, diagnose faults or monitor the functioning.

Command buttons
The command buttons on the left of the control bar are used to open additional windows.
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Opens the Setup window (see page 92).

Note: This feature is available to Engineer access level only.

Opens the Manual Mode window (see page 55).

Opens the Printer Setup window (see page 60).

Opens the Diagnostics window (see page 93).

Saw loading options
These checkboxes offer additional cutting options during production.

Note: these options are overrides and will not change the quantities cut of the
selected members (i.e. if there are two of the same members to cut, enabling
2* Thick will only count as cutting one member).

2* Thick: indicates to the saw that two pieces of timber are stacked one on top of the
other.
2* Wide: indicates to the saw that two pieces of timber are stacked side by side.
Rotate: indicates to the saw that the stick is rotated 90° from the position initially set
in the file (flat or on its edge).

Note: this may be useful when the saw is not able to perform a cut in the ini-
tially set position.

Simulation: simulates the cutting functions when Simple is unable to communicate
with the saw.

Note: this option is hidden when communication with the saw is present.

Speed sliders
These sliders will dynamically change the speed of the saw's feed rates while cutting and
can be changed at any time:

Cutting Speed: alters the speed of the cutting action while in a cut (i.e. the speed at
which the blade is moved through the timber, not the actual speed of the blade itself).
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Moving Speed: alters the speed of the timber when moving through the saw from
one cut position to another.

Monitoring panel
The monitoring panel on the right of the control bar gives the current position and status of
any particular axis or feeder, as well as the status of the feeder sensors, clamp rollers and
saw blade.

Note: the colour of the indicator light gives the current status as follows:
Normal operation (ready and active)
Not homed or on software limits
Presence of a fault (Amp Fault or Urgent FE error)
Not initialised

Gives the current position and status of the left feeder.

Gives the current position and status of the Y-axis.

Gives the current position and status of the Z-axis.

Gives the current position and status of the B-axis.

Gives the current position and status of the C-axis.

Gives the current position and status of the right feeder.

Indicates that the cor-
responding top clamp
roller is in the idle posi-
tion (away from the timber).

Indicates that the cor-
responding top clamp
roller is in the actuated
position (clamped against
the timber).

Indicates that the cor-
responding feeder sensor
is obstructed (timber is
detected).

Indicates that the cor-
responding feeder sensor
is clear (timber is not
detected).
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Indicates that the cor-
responding side clamp
roller is in the idle posi-
tion (away from the timber).

Indicates that the cor-
responding side clamp
roller is in the actuated
position (clamped against
the timber).

Indicates that the saw
blade is off.

Indicates that the saw
blade is on.

Gives the current speed of the saw blade (in rpm).

Machine Name
The machine name is displayed just below the cutting speed slider. This can help identify
the machine during remote access.

Note: the machine name can be changed in the General tab of the Options window
(see page 38).

Message bar
The message bar is located just below the speed sliders. It shows the login name of the cur-
rent user, messages relating to any function currently running, as well as warning mes-
sages.

Uptime counter
The uptime counter is located just below the speed sliders. It indicates how long the saw
has actually been cutting since midnight.

Error notification
An error notification icon can be displayed at the right end of the control bar.

Note: "Error Codes" must be selected as Error System in the General tab of the
Options window (see page 38) for the icon to be displayed.

The icon indicates the following:

No error is present.
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One or more errors occurred and attention is required.

Note: Critical errors and errors that require immediate operator
action will force the Error Notification window to pop up (see
image below). To show information about other errors or to
reopen the window, you can click the flashing icon at any time.

This window gives a description of the error. If there are multiple errors pending, you can
switch between them by clicking the tabs at the top of the window. The "What to do now"
section has instructions for immediate action to continue cutting. The "What to do next" sec-
tion contains instructions to fault-find the issue if it will not clear. Some errors can simply be

dismissed by clicking .

WoodRunner status (third-party product)

If a WoodRunner is installed, a dedicated icon will be displayed at the right end of the con-
trol bar.

Note: "WoodRunner" must be selected as Bunk Feeder in the General tab of the
Options window (see page 38).

The icon gives the current status as follows:

The connection to the WoodRunner is active.
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The connection to the WoodRunner is disabled. To enable it, do the fol-
lowing:

1. Click the icon to open the WoodRunner interface (see image
below).
2. Check Enabled.

The connection to the WoodRunner has not been initiated or has failed.
To solve the issue, do the following:

1. Click the icon to open the WoodRunner interface (see image
below).
2. Check the connection details.

3. Click .

CAUTION
WoodRunner connection settings must not be altered unless communication
issues have been diagnosed.
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MATERIALS LIST
The Materials List window shows all the materials required to cut the members based on
the current optimisation. The window includes two separate lists labelled Quantity
Summary and Loading Order. Basic metrics about the current optimisation are displayed at
the right of the window (for more details about those metrics, see Results file on page 54).

Access
To open the Materials List window, do one of the following in Simple once a file is open:

Click on the toolbar.

SelectMaterials List from the View drop-down menu.

Quantity Summary
The Quantity Summary list gives the dimensions and amount of each type of timber that is
required. This list is used by the pickers when collecting the timbers from the yard.

Note: the Bin column indicates in which bunk the timber is located if an automated
timber retrieval system is installed.

Loading Order
The Loading Order list gives the exact order in which the timbers should be loaded into the
saw.
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This list may also show a "2xW" or "2xH" in the right-most column to indicate that certain
pieces of timber are cut in a stacked formation. "2xW" means that two pieces of timber are
stacked side by side (horizontally). "2xH" means that two pieces of timber are stacked one
on top of the other (vertically). In either case, the real amount of timbers needed is indicated
in parentheses next to the primary quantity.

Note: Two consecutive lines of the same colour (white or purple) indicate a stack
of timbers with two different thicknesses or grades. The second line indicates the
timber that is either at the top of a vertical stack, or away from the fenceline in the
case of a horizontal stack. The left-most column gives the position of the timber in
the stack as follows: TOP, BOT (bottom), F (against the fenceline) or NF (away
from the fenceline).

E X A M P L E

The above list gives the following loading order:
l three consecutive horizontal stacks (six identical timbers in total)
l two consecutive vertical stacks with one 35-mm-thick timber at the bottom and
one 45-mm-thick timber at the top (four timbers in total)

l one vertical stack with a 45-mm-thick timber at the bottom and a 35-mm-thick tim-
ber at the top

l one horizontal stack with an "H1.2" timber against the fenceline and an "H3.1" tim-
ber away from the fenceline

A picklist determined by the loading order can be generated and used as follows:

Click to export the picklist as an XML file.

Click to make the picklist available for the Linear Pickline to fetch (if
installed).

OPTIONS

Note: This feature is available to Supervisor and Engineer access levels only.

Options 37



The Options window makes it possible to customise the interface and operation of the saw.

Access
To open the Options window, do one of the following in Simple:

Click on the toolbar.

Once a file is open, select Options... from the Tools drop-down menu in the Simple
menu bar.

General

The General tab relates to the overall running of the saw.

Machine Name: specifies the name of the machine to be displayed on the Control
Bar (see page 33) and on the Statistics webpage (see page 89).
Site Name: specifies the name of the site to be displayed on the Statistics webpage
(see page 89).
Webserver Port: specifies the local port number used to access the Statistics
webpage (see page 89).
Bunk Feeder: specifies whether an automated timber retrieval or feeding system is
installed and which kind.
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Note: when "Linear Pickline" is selected, the communication port used to
fetch the picklist can be set in the Picklist Port field (see page 37).

Error System: specifies which of the Diagnostics window (see page 93) or the new
error reporting system (Error Codes) will pop up when an error occurs.

Note: If "Error Codes" is selected, an error notification icon will be displayed
on the control bar (see page 33). By selecting "None", no error window will
ever pop up. The Diagnostics button remains available regardless.

Automatically run job upon loading: begins the cutting sequence immediately after
a job file has loaded.
Auto-scroll when running job: synchronously scrolls through the list as the cutting
sequence is taking place.
If unchecked, the display will stop scrolling back constantly to each new member
being cut.
Expand members upon running: enables a zoom effect in the Member List or
Optimised tab when a cutting sequence begins.
Ask quantity multiplication factor for file members: asks a value to multiply all
members in the job file upon loading.

Note: this feature is for .smp and .trs files only.

Draw editing boxes in the member list view: draws boxes around the editable para-
meters on the Member Diagram (see page 28) when the Member List tab is active.
Metric: switches from imperial to metric units.

Note: you must restart Simple for the change to take effect.

Add undercuts using opening data: enables undercuts to be performed on mem-
bers that are used for openings (e.g. window, door...) if relevant data are available in
the file.
Add dot to repeated truss names when processing batches (Omni XML files
only): rename each new instance of the same truss with an additional dot when
found in a separate batch section of the Omni XML file.
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Optimisation

The Optimisation tab is used to configure the optimising algorithm according to the plant's
requirements.

Look Ahead: specifies how far the optimising algorithm should look ahead in the file
to find members to combine. The entity or field that will be looked at (most commonly
truss) can be selected from the drop-down list.

E X A M P L E
If set to "0" and "Trusses" is selected from the drop-down list, the optimising
algorithm will only consider the current truss to combine members into the
stock length before selecting a new stick. If set to "1", the algorithm will con-
sider the current truss and the next one in the list to combine members into the
stock length before selecting a new stick and so on. Increasing the Look Ahead
value will therefore improve the optimisation.

Members: This will look at the member name for combining members. If all mem-
bers to be optimised have a quantity of "1" and the Look Ahead value is set to "0",
only one member will be placed into each stock length. However if the
Look Ahead value is increased to "2", there is a potential that there will be three
members with different names combined into each stock length.
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Trusses: This will look at the truss name for combining members. However it
can only consider members of that truss and subsequent trusses with identical
material. If there are five members with identical material in each truss and the
Look Ahead value is set to "0", there is a potential that all five members of the
same truss will be combined into one stock length (members of a different truss
will be ignored for that stock length). If the Look Ahead value is increased to "1",
there is a potential that members of two different trusses will be combined into
the same stock length.
Pieces of same material: This will look at the material name for combining mem-
bers. If all members to be optimised have a quantity of "1", they are all the same
material and the Look Ahead value is set to "0", only one member will be placed
into each stock length. However, if the Look Ahead value is increased to "2",
there is a potential that there will be three members combined into each stock
length.

On-the-fly Look Ahead: specifies how far the optimising algorithm should look
ahead in the selection to find members to combine for an on-the-fly optimisation.
Scaling: relates to the priorities associated with any particular piece of timber.

Priority Emphasis: specifies the weighting that is placed on the material priority
as defined in the materials database. Changing this will affect what timber will be
chosen based on the priority of the timber. If set to "100", the algorithm will
always select the top priority timber where possible. If set to "0", the algorithm will
always select the configuration with least amount of waste regardless of timber
priority.

Note: the highest priority timber may also produce the least amount of
waste.

Auto Waste: uses the most waste-efficient optimisation that is found according to
the Min,Max and Cnt values defined below. With this enabled, the algorithm will
be run many times with the different Priority Emphasis values as defined by Min,
Max and Cnt. At the end of the process, the algorithm will choose the optimisation
of highest Priority Emphasis that also produces the least amount of waste. This
means you will always get the best waste reduction regardless, but it increases
the chances of also getting the best timber utilisation possible based on preferred
timber.
Auto Cost: uses the most cost-efficient optimisation that is found according to
the Min,Max and Cnt values defined below. This works exactly the same as the
Auto Waste feature, but will look at minimising total cost of the job rather than
waste.
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Note: to use this feature, all stock materials must have an entry greater
than $0 in the Cost column of the materials database, and this must be
up-to-date to provide accurate results.

Min: lowest Priority Emphasis scale value (0 to 99) used by the algorithm while
iterating through optimisation scenarios for the Auto Waste and Auto Cost fea-
tures.
Max: highest Priority Emphasis scale value (1 to 100) used by the algorithm while
iterating through optimisation scenarios for the Auto Waste and Auto Cost fea-
tures.
Cnt: number of iterations performed by the algorithm in even increments between
the Min and Max values while trying to find the best optimisation scenario for the
Auto Waste and Auto Cost features.

E X A M P L E

IfMin is set to "20",Max is set to "80" and Cnt is set to "4", the algorithm will
be run four times at a priority emphasis of 20, 40, 60 and 80 of which the
scenario with the lowest waste or cost will be selected.

Force member separation distance: specifies the length of timber that should be
cut between two members when not sharing a cut.
Stack: enables the optimising algorithm to use stacked materials.

Thickness: enables the materials to be stacked one on top of the other.
n Before stick optimisation: attempts to create stacks of individual members
and then to combine those stacks in a stack of timbers.

n After stick optimisation: attempts to combine members in a timber and
then to stack that timber with another one.

Note: The Before stick optimisation may cause more stacking and thus
be more time-saving, but may also produce slightly more waste. On the
contrary, the After stick optimisation may cause less stacking and thus be
more time-consuming, but may also reduce waste.

Top/Bot. Plates: enables the top and bottom plates of a same frame to be
stacked one on top of the other or cut side by side in case of trenching.
Only stack identical materials: prevents the optimising algorithm from stacking
different materials (with a different description, width or thickness), whether it be
one on top of the other or side by side.
Mitred Members: enables side-by-side stacking of mitred members where pos-
sible.
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Flip Members to Fit: enables the members to be flipped either length-wise or width-
wise based on the length of the individual member.

Notes:
l The flipping of members is performed to try and achieve an optimal solu-
tion by sharing cuts wherever possible. However, because some mem-
bers (such as top and bottom chords) require the timber bow to coincide
with the geometry of the member, it may be necessary to disable flipping.

l When the following values are changed, any open files need to be
reloaded for the change to take effect.

Sideways if shorter than: specifies the maximum length allowed to flip a mem-
ber width-wise.

Note: if a member is flipped sideways, no Truss Markings will be printed
on it (see page 63).

Lengthways if shorter than: specifies the maximum length allowed to flip a
member length-wise.

Sorting

The Sorting tab contains two lists that are used to group certain members together based
on different criteria before and after the optimisation.
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Note: the following rules apply:
l The number "0" will not perform any sorting based on that field.
l A number different from "0" will define the position of that field in the sorting
order ("1" being first, "2" being second, "3" being third and so on).

l A positive number will perform the sorting based on that field in ascending order
(lowest first) and a negative number will perform the sorting in descending order
(highest first).

Pre-Optimisation: determines the order in which the members are fed into the optim-
ising algorithm.
Using pre-optimisation sorting will have very different effects on waste reduction and
cutting order depending on how it is set up. This does not help control the infeed side
of the saw, only what members are more likely to be cut first.
Post-Optimisation: determines the order in which the optimised sticks are listed in
the Optimised tab at the end of an optimisation.
Using post-optimisation sorting will not affect the waste in any way, it will simply re-
arrange what order the timber is loaded on the infeed, making the loading process
simpler and more efficient. It will however affect the order in which members are cut.

E X A M P L E

In the Pre-Optimisation list, if the Truss field is set to "1", the Length field to "-2" and
the other fields to "0", all members will be grouped by truss first and then sorted by
length in descending order within each truss before being processed by the optim-
ising algorithm.
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Offcuts

The Offcuts tab is used to manage how the waste materials are automatically reused to pro-
duce useful pieces like wedges or wall noggins.

Offcuts Enabled: enables the Offcuts feature.

Note: if unchecked, the activation status of each offcut will have no effect.

Maximum offcut blocks / wedge pairs / custom offcuts per length of timber: spe-
cifies the maximum number of offcuts (or pairs of wedges) allowed per stick.
Maximum waste length to include offcuts (in mm): specifies the maximum length of
the waste capable of getting offcuts inserted into the stick.

Note: If the waste associated with a stick is greater than either of these two
previous values, no offcuts will be inserted and the waste will be spared for
future use. To ignore one of these options, "0" should be entered into the
associated field.

Minimum reusable waste length: specifies the minimum remaining waste length
(after offcuts) required to insert a reusable block into the stick.
Generic Kickoff Location for all offcuts: specifies the kickoff location for all offcuts
if a kickoff system is installed.
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Blocks / Wedges / Custom: different types of offcuts to select from (squared-off nog-
gins, wedges or custom members)

Note: if Custom is selected in the previous option, the table will show the cus-
tom members created in the Complete Member Editing window (see page
78).

Insert (table): adds a new row to the table with the type of offcuts selected in the pre-
vious option (Blocks orWedges only).
Delete (table): removes the selected row from the table (Blocks orWedges only).

Note: You can sort the offcuts by clicking any column header. Click a column
header to sort the offcuts in ascending order based on that column. Click the
same column header again to sort the offcuts in descending order.

The following properties can be defined in the table:

: activation status of the offcut (check to enable or uncheck to disable the
offcut)
Offcut: name of the offcut (e.g. Block255)
Material: material to be used for the offcut

Notes:
l If a material is specified in this field, the description must be exactly
the same as the one in the Materials tab, and the width and thickness
specified in the next two columns must match this material.

l If this field is left blank, the optimising algorithm will use any material
that matches the width and thickness specified in the next two
columns.

Width (in mm): width of the material to be used for the offcut
Thickness (in mm): thickness of the material to be used for the offcut
Length (in mm): length of the block (for blocks only)
Rise (in mm): rise of the wedge (for wedges only)

Note: this value should be equal to the width of the material.

Run (in mm): run of the wedge (for wedges only)
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Materials

The Materials tab provides access to the materials database that contains information relat-
ing to the timbers used in the plant.

Note: optimising can only occur with the timbers listed in the materials database.

Leavec mm of material uncut: specifies the length of timber in each stick that is
seen as unusable by the optimising algorithm.
Ignore quantities: disables the inventory control performed by the saw.
If unchecked, the saw will only use the materials with a number greater than "0" in the
Avail. column and reduce this quantity by one each time a specific type of timber is
cut.
Cut bin 7 last (pack feeder): enables the materials from the last conveyor of the
Packfeeder (optional) to be cut after the materials from the six bunks.
This is to ensure all materials that require manual handling will be processed in a
row.
Ignore timber description while optimising: enables the optimising algorithm to
pick timbers based on their width and thickness only (the material description is not
taken into account).
Add newmaterial (table): adds a new row to the materials table.
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Note: You can sort the materials by clicking any column header. Click a
column header to sort the materials in ascending order based on that column.
Click the same column header again to sort the materials in descending
order.

The following properties can be defined in the table:

Material: material description to be used to match with material descriptions in a
file

Note: the description must be exactly the same as what is read in from a
file.

Length (in mm): length of the timber
Width (in mm): width of the timber
Thickness (in mm): thickness of the timber
Bin: bunk the timber is located in if an automated timber retrieval system is
installed
Priority: priority each type of timber is to be used in

Notes:
l A priority of "0" disables the material.
l A material with a priority of "1" will try to be used first.
l It is not advisable to have two lengths of the same material with the
same priority. The best practice is to start with the longest stock length
at priority "1" and work in descending order to the shortest one.

Cost: cost per metre of the timber

Note: optimising and statistics use this value.

Used: number of pieces of this particular timber that have been used to date
Available: number of pieces of this particular timber that are still available

Note: this value is used for inventory control (if Ignore quantities is not
enabled).
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Kickoff

The Kickoff tab is used to set rules that automatically determine which kickoff location to
send a member to. Those rules are applied to all the members in the Member List tab when
a job file is loaded. This will override any kickoff location already set in the job file. For
more details, see Kickoff Rule Syntax on page 94.

Delete Rule: removes the selected rule from the list.
Move Up: moves the selected rule up one row, increasing its priority in the list.
Move Down: moves the selected rule down one row, decreasing its priority in the list.

Note: when opening an optimised job file, the kickoff locations may differ between
the Member List tab and the Optimised tab until you re-optimise the file with the cur-
rent kickoff rules.
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Statistics

The Statistics tab is used to manage how the daily and monthly reports are generated (see
page 90).

Maximum Command Execution Time: specifies the maximum time allowed
between saw command executions for the system to be seen as in production.
Sampling Period: specifies the time interval between two samples.
Monthly Statistics Interval: specifies the time interval used to update the monthly
reports.
PRD Output: specifies the output directory and other settings related to Production
Feedback files.
Check Enabled to enable the generation of PRD files.

Note: PRD files are specifically designed for MiTek customers. For more
information, please contact MiTek.

RPF Output: specifies the output directory and other settings related to Real-time Pro-
duction Files.
Check Enabled to enable the generation of RPF files.

Note: RPF files are specifically designed for Pryda customers. For more
information, please contact Pryda.
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Exit
To exit the Options, do one of the following:

Click  .
The changes are saved.

Close the Options window.
All changes are lost.

Click  .
All changes are lost.

BATCH OPTIMISE

Note: This feature is available to Supervisor and Engineer access levels only.

The Batch Optimise window makes it possible to optimise several files without having to
load them separately. The files are then saved in their optimised state (for more details, see
Save a file on page 12, step 4).
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To open the Batch Optimise window, select Batch Optimise... from the Tools drop-down
menu in the Simple menu bar.

To run a batch optimisation, do the following:

1.Make your file selection.
2. Define the output options.

3. Click .

Note: All the selected files are processed regardless of whether they are locked or
not. All the members present in the selected files are processed regardless of
whether they are tagged as cut or not.

File selection
To add files to the selection, do the following:

1. Click .
2. The following window pops up:

Browse for the file(s) you wish to add.

Note: you can select several files by pressing and holding down either the
⇧ key for consecutive files or the Control key for non-consecutive files.

3. Select the file(s) and click .
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To add an entire folder to the selection, do the following:

1. Click .
2. The following window pops up:

Browse for the folder you wish to add.

3. Select the folder and click .

To remove files from the selection, select the file(s) you wish to delete and click .

Note: you can select several files by pressing and holding down either the ⇧ key
for consecutive files or the Control key for non-consecutive files.

To empty the selection, click .

Output options
The following output options are available:

Optimised Files
Prompt for missing materials: displays the Add Materials window (see page
13) if a file requires missing materials.

Note: To apply the same rule to every file in the batch, check Do this
action for all files in the Add Materials window and click either of the fol-
lowing:

The members requiring missing materials will not be optim-
ised.

The missing materials will be added as new materials in the
materials database (see page 47).
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Print materials list: sends the materials list of every optimised file for printing
(see page 36).
Save optimised file: saves the optimised files according to the options defined
below.
Destination folder: specifies the destination path for the optimised files.

Note: The optimised files are saved as Simple files version 2 (*.smp2).
You can either type in the destination path directly into the field or click
to browse for the destination folder.

File name prefix: specifies the character string to be added before the name of
every optimised file.
Locked: The file and the embedded optimisation will be locked. It will never be
possible to modify the file or run an optimisation again, except through the Batch
Optimise feature.

Results File
Enabled: creates a spreadsheet with the results of the batch optimisation.
File path: specifies the destination path and name of the results file.

Note: The results file must be saved as a spreadsheet (*.xls).
You can either type in the destination path and file name directly into the
field or click to open the Save As window.

Show results when done: opens the results file once the batch optimisation is
complete.

Results file
The results of the batch optimisation are summarised in a spreadsheet that consists of the
following columns from left to right:

File: path of the file the row of data relates to
# Timber Lengths: number of timbers required
# Members: number of members optimised
# Stacked Members: number of members optimised in a stack formation
% Stacked Members: percentage of members optimised in a stack formation out of
the total number of members optimised
Total Material Length: total length of material required
Total Usable Length: total length of material used for members and offcuts
Total Member Length: total length of the members optimised
Total Offcut Length: total length of the offcuts produced
Total Waste: total length of waste (reusable or not)
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Total Waste To Bin: total length of non-reusable waste
%Waste To Bin: percentage of non-reusable waste out of the total length of material
required
Total Reusable Waste: total length of reusable waste
%Reusable Waste: percentage of reusable waste out of the total length of material
required
Material Cost: total cost of the materials required
All Members Optimised: indication whether all the members of the file were optim-
ised or not

Note: the orange-highlighted lines identify the files that could not be optim-
ised completely.

MANUAL CONTROL

Manual Mode
The Manual Mode window is used to manually move and control the saw. This is useful
during maintenance, diagnostics and calibration procedures.
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Access
To open the Manual Mode window, do one of the following:

Click on the Control Bar (see page 30) in Simple.
Press the yellow MANUAL button on the operator console.

Feeders
The upper section of the window controls the feeders (X-axis).

DANGER
If the saw either has timber clamped or has had timber clamped and the lead-
ing/trailing ends are not cleared, the clamp rollers may actuate at any time.
Under no circumstances should you place any body part in the feeders while
using these buttons.

Keep pressed to move both the left and right feeders in the left direction.

Keep pressed to move the right feeder in the left direction.

Keep pressed to move the left feeder in the left direction.

Keep pressed to move both the left and right feeders in the right direction.

Keep pressed to move the right feeder in the right direction.

Keep pressed to move the left feeder in the right direction.

Slide to adjust the feeder speed (from 0% to 100%).

Click to zero the current feeder positions.

Saw head
The middle section of the window controls the saw head.
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Sawmoves

Keep pressed to move the saw towards the door on Y-axis.

Keep pressed to move the saw away from the door on Y-axis.

Keep pressed to move the saw upwards on Z-axis.

Keep pressed to move the saw downwards on Z-axis.

Keep pressed to move the saw blade towards the horizontal position on
B-axis.

Keep pressed to move the saw blade towards the vertical position on
B-axis.

Keep pressed to move the saw counter-clockwise on C-axis (viewed
from the top).

Keep pressed to move the saw clockwise on C-axis (viewed from the
top).

Slide to adjust the speed of the above movements (from 0% to 100%).

Click to require a rehoming cycle before the next start. Make sure the
STOP and MANUAL lights are on and press the green START button on
the operator console to start the rehoming cycle.

Click to move the saw to the park location (blade facing the door). This
can be used to position the saw head properly for changing the blade.

Saw blade

Click to turn the saw blade on and off. Click once to start the saw blade.
Click a second time to stop it.

Slide to adjust the saw blade speed from 0% (0 rpm) to 100% (about
5500 rpm).

Peripherals
The lower left section of the window controls some peripherals.

Click once to run the waste conveyor towards the waste bin. Click a
second time to stop it.
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Click once to run the waste conveyor towards the door. Click a second
time to stop it.

(optional)

Click once to start the dust extractor and the extended waste conveyor.
Click a second time to stop.

Notes:
l This button can only be used if the saw is homed.
l It will only stop the dust extractor after a delay of one minute.

(optional)

Click to open the Material Handling window (see page 58).

Other features
The window includes other specific features.

Click to open the Length Calibration window.

Note: This feature is available to Supervisor and Engineer
access levels only.

These values are used for the calibration of the re-referencing system.

Exit
To exit the Manual Mode, do one of the following:

Close the Manual Mode window.
Press the yellow MANUAL button on the operator console.

Material Handling
The Material Handling window is used to manually control the AIT (Automatic Infeed
Table) and OFK (Outfeed Kickoff Table).
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Access
To open the Material Handling window, do the following:

1. Access the Manual Mode (see page 56).
2. Click .

Automatic Infeed Table
The left section of the window controls the AIT.

Note: The AIT needs to be enabled for these buttons to operate. Make sure the AIT

toggle button on the toolbar looks like this: 

Click once to run the infeed conveyor forward (towards the saw). Click a
second time to stop it.

Click once to run the infeed conveyor in reverse (away from the saw).
Click a second time to stop it.

Click once to run the side transfer conveyor forward (towards the infeed
conveyor). Click a second time to stop it.

Click once to run the side transfer conveyor in reverse (away from the
infeed conveyor). Click a second time to stop it.

Click to raise the infeed conveyor.

Click to lower the infeed conveyor.
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Outfeed Kickoff Table
The right section of the window controls the OFK.

Click once to run the outfeed conveyor forward (away from the saw).
Click a second time to stop it.

Click once to run the outfeed conveyor in reverse (towards the saw).
Click a second time to stop it.

Click to extend the kickoff arm on the outfeed conveyor.

Click to retract the kickoff arm from the outfeed conveyor.

Exit
To exit the Material Handling, do one of the following:

Close the Material Handling window.
Click .

PRINTING

Printer Setup
The Printer Setup window is used to specify the information and truss- or frame-related
markings to be printed on the members, to customise the members with your company's
name or logo, and gives access to the Plate Marking Control Panel (see page 67).
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To open the Printer Setup window, click on the Control Bar (see page 30).
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Markings  Supervisor and Engineer access only 

When you click , the above window pops up.

Member Designation

The Member Designation Label (see page 66) can be printed on the edge and on the top
side of the members. The following options are available:

Print Member Designation: enables the printing of the Member Designation Label.
Sides: specifies where the Member Designation Label is printed.

Side: prints on the edge of the members.
Top: prints on the top side of the members.
Side & Top: prints on both the edge and the top side of the members.

Flip Top Member Des.: turns the top-printed Member Designation Label upside
down.
Flip Side Member Des.: turns the edge-printed Member Designation Label upside
down.
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Truss Markings

These settings make it possible to print the following truss-related markings on each mem-
ber:

A Nail Plate Guide is printed wherever a nail plate is supposed to be. It
shows the portion of the nail plate positioned as it should be when fixed
to the member. A scale must be defined in the Nail Plate Scale field (100%
corresponds to the actual size).

Note: The nail plates located along certain members (not at the
ends) are sometimes represented by a single line that shows
approximately where the edge of the nail plate should be. This is
to address the possible variation in the position of the nail plates
at those junctions on the actual truss.

The Truss Diagram shows an overview of the entire truss that contains
the member. The member itself is shown in black. The diagram is ori-
ented so that it is level when the member is positioned in the intended ori-
entation.

A Junction Label is printed wherever a junction with another member is
supposed to be. It shows the designation of the other member that is
present at the junction. The arrow indicates which way the designated
member is located.

A Camber Value is printed close to the junction label wherever a camber
is needed. The number after the C letter gives the camber value (in mm)
that should be applied at the junction.

A Jack Intersection marking is printed on the edge wherever an inter-
section with a jack truss is supposed to be. The arrow indicates which
way the jack truss is located. Information about to the intersecting jack
truss is printed next to it.

Notes:
l A black rectangle aligned with the arrow is printed on the top
side for better visibility from above.

l Two opposite arrows are shown if there is a jack truss on both
sides.
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A Truss Bootmarking is printed on the top side wherever a truss boot is
supposed to be. Details about the truss boot is printed next to it (if
present in the job file). Each connected truss is represented by a crossed
square.

Note: if the marking cannot be printed on the actual side, it will
be dashed to indicate that the truss boot is actually on the oppos-
ite side.

An Overhang marking (OH) is printed wherever an overhang is sup-
posed to start. This can include either or both of the following:

an Overhang Line showing the exact starting point of the overhang
on the member
the Overhang Distance indicating the overhang length (in mm) from
the starting point to the end of the member

Frame Markings

These settings make it possible to print the following frame-related markings on each mem-
ber:

A Stud Marking is printed on the edge wherever a junction with a stud
(or another frame component except plate) is supposed to be. It shows
the designation of the component (determined by the detailing software)
that is present at the junction. The marking is oriented as the component
should be when joined to the member.

A Panel Marking is printed on the top side wherever a junction with
another panel (i.e. frame) is supposed to be. It shows the designation of
the panel (determined by the detailing software) that is present at the
junction.

Notes:
l If trench cuts are present on the top side of the member, the
panel marking will be printed on the edge.

l A panel marking that is printed at one end with no separating
lines indicates that the joined panel is against the end of the
member.
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The Panel Number is printed on the top side of plates only (top, very top
or bottom plate). It shows the designation of the panel (i.e. truss name)
the plate belongs to.

Notes:
l If Flip Panel Number is checked, the panel number will be
turned upside down.

l If trench cuts are present on the top side of the plate, the panel
number will be printed on the edge.

Click to apply the changes and close the window.

Company Name  Supervisor and Engineer access only 

When you click , the above window pops up.

Your company's name or logo can be printed along with the Member Designation Label
(see page 66) on the edge and on the top side of the members. The following options are
available:

Off: disables the feature (no text or logo will be printed).
Text: enables the company name to be printed as text.
Type the company name in the text box and check Italics if you want it to be printed in
italics.
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Note: the font defined in the Font Name field (see Other features on page 69)
will be used to print the company name.

Image: enables the company name or logo to be printed as an image.
1. Click .
2. Browse for the .bmp file you wish to use.
3. Select the file and click , or just double-click it.

MinimumMember Length (in mm): specifies the minimummember length allowed
for the company name or logo to be printed.

: displays the types of members the company name or logo can be prin-
ted on.

Note: to add or remove a member type, please contact Vekta Automation.

Print Location: specifies where the company name is printed.
Side: prints on the edge of the members.
Top: prints on the top side of the members.
Side & Top: prints on both the edge and the top side of the members.

A print preview of the company name or logo is displayed in the bottom part of the window.

Click to apply the changes and close the window.

Member Designation Label  Supervisor and Engineer access only 

This section of the Printer Setup window is used to specify what information is auto-
matically printed on the members and how it is printed.

Note: The Member Designation Label defined here is the default one. It may be
overridden if different settings are present in Simple's configuration files.

The following options are available:

Leading End: prints closer to the leading end of the member.
Trailing End: prints closer to the trailing end of the member.
Font Size: specifies the size of the text printed.

Small: allows two line(s) of information to be printed.
Large: allows only one line of information to be printed (Line 1).

Line 1 & Line 2: each line can contain a combination of four pieces of information to
choose from the following:

Job: designation of the job the member belongs to
Truss: designation of the assembly the member is part of
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Member: designation of the member within the assembly
Type: abbreviated type of member (top/bottom chord, top/bottom plate, web...)
Length: overall length of the member including any automatic length adjustment
Nominal Length: overall length of the member as it appears in the job file
Quantity: member number out of the total quantity of the same member
(e.g. "1 of 2")
Total Quantity: total number of the same member to be cut
Truss Order: order number of the assembly according to the position of its first
occurrence in the job file

Note: sorting the members in the Member List tab based on a particular
column will not change the truss order.

Filename: name of the job file without the extension
ID: string used for troubleshooting (for Vekta use only)
Bundle: number of the bundle (stack) containing the assembly the member is
part of
Bundle Row: number of the bundle row containing the assembly the member is
part of
Bundle Row Pos: position in the bundle row of the assembly the member is part
of

Notes:
l To leave a field empty, click it and press the Delete key, or right-click it
and select Delete from the context menu.

l You can also type in a custom entry in any box that will appear unchanged
on all members.

l You can enable or disable the Member Designation Label, and choose its
printing location in the Marking Settings window (see page 62).

Click to apply the changes and close the window.

Plate Marking Control Panel
The Plate Marking Control Panel is used to configure, monitor and troubleshoot the printer.
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Access
To open the Plate Marking Control Panel, do the following:

1. Access the Printer Setup window (see page 60).

2. Click .

Print modules
The machine is equipped with two print modules and each one of them controls eight print
heads located as follows:

n Print module 1
l Heads 1 to 4: side print heads
l Heads 5 to 8: first row of top print heads

n Print module 2
l Heads 9 to 10: first row of top print heads
l Heads 11 to 16: second row of top print heads

The print modules can be managed and monitored using the following features:

Enable Print Module 1 & 2: enables or disables printing on the module.
A message next to the checkbox gives the current status of each print module.
Installed: enables or disables printing on the head.

Note: it can be useful to disable one particular head that is not working pro-
perly in order to keep the whole module running.
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The colour of the indicator lights gives the current status of each print head as fol-
lows:

The print head is ready.
The print head is not calibrated / not ready.
The print head is not available.
The print head is disabled (Installed unchecked).

: triggers a purge of the print heads for each print module inde-
pendently.

Note: A purge may be necessary if the printer has not been used for a long
time or if the ink has dried. Both buttons can be used at the same time. Make
sure to place a cloth or sheet of paper in front of the corresponding print
heads before starting the purge.

Other features
The following are available at the bottom right of the Plate Marking Control Panel:

Font Name: specifies what font is used for all the information printed on the mem-
bers.

Notes:
l This feature is available to Supervisor and Engineer access levels only.
l The font must be installed on the computer and the exact font name must
be entered (case-insensitive).

l The following font types are supported:
o TrueType (*.ttf)
o TrueType Collection (*.ttc)
o OpenType (*.otf)
o PostScript Type 1 (*.pfb + *.pfm)

l If not all the conditions are met, the default font will be used.

Printer Reset: If the printer is not working properly, it can be reinitialised using one of
the following buttons:

Click to do a soft restart of both print modules (recommended if the
printer is still responding).

Click to force a power cycle of both print modules (only if the printer
is not responding).
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Print Preview
The Print Preview window shows the actual image that will be sent for printing on a spe-
cific member or stack of members according to the settings defined in the Printer Setup win-
dow (see page 60) and Plate Marking Control Panel (see page 67).

Access
To open the Print Preview window for a member, do the following:

1. Right-click the desired member in the Member List or Optimised tab.
2. Select Preview Image... from the context menu.

Note: The Print Preview window for a stack of members can only be opened from
the Optimised tab. Make sure to always select the member listed first in the stack
(not the one displayed in light grey).
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Printable areas

Note: the diagram above is based on a 90-mm-wide material.

The green rectangle delimits the entire printable area.

The numbered squares indicate where each print head prints on the timber (for more
details about the print heads, see Print modules on page 68).

The red dotted lines delimit the following areas:

1. Top side of the horizontally stacked member that is away from the fenceline
2. Top side of a non-stacked member, or top side of the top-stacked member
3. Edge of the top-stacked member
4. Edge of a non-stacked member, or edge of the bottom-stacked member

Controls

 or 

Toggle this button on then click the image to zoom in on the
clicked location.
Alternatively, you can simply scroll up with the mouse wheel to
zoom in.

 or 

Toggle this button on then click the image to zoom out from the
clicked location.
Alternatively, you can simply scroll down with the mouse wheel to
zoom out.

Click to fit the image to the window.
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 or 

Use the arrow keys to move the image around.
Alternatively, you can hold down the right-click button and use the
mouse to move the image around.

MEMBER EDITING

Basic Member Editing
When the Member List tab is active, some parameters of the currently selected member can
be edited directly on the Member Diagram (see page 28).

Note: The editable parameters can be easily identified on the member diagram by
boxes drawn around them (see image below). If they are not already present,
check Draw editing boxes in the member list view in the General tab of the Options
window (see page 38).

Note: Any change will take effect immediately in the Member List and Member Tree
tabs. However, the Optimised tab will only be updated at the next optimisation.
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Edit a designation

To edit the job, truss or member designation, do the following:

1. Double-click the relevant designation on the member diagram.
A window like the one above pops up.

2. Enter the new designation.
3. Click or press the Enter key.

Edit the quantity

To edit the quantity of the member, do the following:

1. Double-click the quantity on the member diagram.
The above window pops up.
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2. Enter the new quantity.

Note: You can use either the physical keyboard or the touch keypad avail-
able on the screen.

To correct the entry with the touch keypad, use the button.

3. Click or press the Enter key.

Edit the material

To edit the material assigned to the member, do the following:

1. Double-click the material description on the member diagram.
The above window pops up.

2. Select the new material from the drop-down list.
3. Click or press the Enter key.
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Edit a dimension

To edit the overall length, or the top, centre and bottom dimensions of the member, do the
following:

1. Double-click the relevant dimension on the member diagram.
A window like the one above pops up.

2. Enter the new value.

Note: You can use either the physical keyboard or the touch keypad avail-
able on the screen.

To correct the entry with the touch keypad, use the button.

3. Click or press the Enter key.
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Edit an angle

To edit the angle of a cut or a bevel angle, do the following:

1. Double-click the relevant angle value on the member diagram.
A window like the one above pops up.

2. Enter the new value.

Note: You can use either the physical keyboard or the touch keypad avail-
able on the screen.

To correct the entry with the touch keypad, use the button.

To reverse the sign of a bevel angle, use the button.

3. Click or press the Enter key.

Complete Member Editing
In order to change the entire shape of a member, create a new member, add special fea-
tures to a member, or manage custom members, it is necessary to open the Complete Mem-
ber Editing window.
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Note: Any change will take effect immediately in the Member List and Member Tree
tabs. However, the Optimised tab will only be updated at the next optimisation.

Edit a member
To edit a member, do the following:

1. Switch to the Member List tab, if not already active.
2. Access the Complete Member Editing window by doing one of the following:

Double-click the member you wish to modify.
Select the member you wish to modify and double-click the member area on the
Member Diagram (see page 28).
Right-click the member you wish to modify and select Add/Edit Member from the
context menu.

3. In the Complete Member Editing window, do at least one of the following:
a. Choose another member type from the drop-down menu at the top of the win-
dow.
b. Enter new parameters in the lower part of the window.

Note: You may need to check Enable Full Member Editing to expand the
lower part of the window. You can click the description of a field to get
additional information about that field.

c. Edit the special features of the member (see page 81).
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4. Click to apply the changes.

Note: you can also click to save the modified member as a

new member in the Member List, or click to save it as a new
custom member (see page 78).

Create a new member
To create a new member, do the following:

1. Switch to the Member List tab, if not already active.
2. Access the Complete Member Editing window by doing one of the following:

Double-click anywhere in the Member List tab.
Double-click the member area on the Member Diagram (see page 28),
whatever member is selected.
Right-click anywhere in the Member List tab and select Add/Edit Member or Add
New Member from the context menu.

3. In the Complete Member Editing window, do the following:
a. Choose a member type from the drop-down menu at the top of the window.
b. Enter the parameters of the new member in the lower part of the window.

Note: You may need to check Enable Full Member Editing to expand the
lower part of the window. You can click the description of a field to get
additional information about that field.

c. Edit the special features of the new member, if required (see page 81).

4. Click to add the new member to the Member List.

Custom members

Note: Custom members are specific members saved separately for future use with
any file. They are intended to be used as offcuts. For more details, see Offcuts on
page 45.

Software Guide



Create a custommember

To create a custom member, do the following:

1. Switch to the Member List tab, if not already active.
2. Access the Complete Member Editing window by doing one of the following:

Double-click anywhere in the Member List tab.
Double-click the member area on the Member Diagram (see page 28),
whatever member is selected.
Right-click anywhere in the Member List tab and select Add/Edit Member or Add
New Member from the context menu.

3. In the Complete Member Editing window, do the following:
a. Choose a member type from the drop-down menu at the top of the window.
b. Enter the parameters of the new custom member in the lower part of the win-
dow.

Note: You may need to check Enable Full Member Editing to expand the
lower part of the window. You can click the description of a field to get
additional information about that field.

c. Edit the special features of the new custom member, if required (see page 81).

4. Click .
5. The following window pops up:

Enter a designation for the new custom member
and click  .

Edit a custommember

Note: the designation and length of a custom member can be changed directly in
the Offcuts tab of the Options window (see page 45).

To edit a custom member, do the following:

1. Switch to the Member List tab, if not already active.
2. Access the Complete Member Editing window by doing one of the following:

Double-click anywhere in the Member List tab.
Double-click the member area on the Member Diagram (see page 28),
whatever member is selected.
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Right-click anywhere in the Member List tab and select Add/Edit Member or Add
New Member from the context menu.

3. Click .
4. The following window pops up:

Select the custom member you wish to modify
and click  .

5. In the Complete Member Editing window, do at least one of the following:
a. Choose another member type from the drop-down menu at the top of the win-
dow.
b. Enter new parameters in the lower part of the window.

Note: You may need to check Enable Full Member Editing to expand the
lower part of the window. You can click the description of a field to get
additional information about that field.

c. Edit the special features of the custom member (see page 81).

6. Click to save the modified custom member as a new custom mem-
ber.
7. The following window pops up:

Enter a designation for the new custom member
and click  .

8. Delete the former version of the custom member, if required (for more details, see
Delete a custom member on the facing page).

Note: you can also click at step 6 to save the modified custom mem-
ber as a new member in the Member List.
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Delete a custommember

To delete a custom member, do the following:

1. Switch to the Member List tab, if not already active.
2. Access the Complete Member Editing window by doing one of the following:

Double-click anywhere in the Member List tab.
Double-click the member area on the Member Diagram (see page 28),
whatever member is selected.
Right-click anywhere in the Member List tab and select Add/Edit Member or Add
New Member from the context menu.

3. Click .
4. The following window pops up:

Select the custom member you wish to delete
and click  .

Special features

Depending on which member type has been chosen at the top of the window, some or all
of the following special features can be added to the member:

l Single bevel cut on either side
l Double bevel cut on either side
l Birdsmouth cut

To access the Special Features window, click in the Complete Member Edit-
ing window.
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To add a special feature to the member, do the following:

1. In the left part of the window, select a special feature you wish to add.

2. Click .
3. In the case of a birdsmouth cut, the following window pops up:

Enter the parameters of the birdsmouth cut and

click  .

To remove a special feature from the member, do the following:

1. In the right part of the window, select a special feature you wish to remove.

2. Click .

To modify an existing birdsmouth cut, do the following:

1. In the right part of the window, select a birdsmouth cut you wish to modify.

2. Click .
3. The following window pops up:

Enter the new parameters of the birdsmouth cut

and click  .
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Once all the special features you wish to add to the member are listed in the right part of
the window, click to apply the changes.

3D MODEL
The 3D Model window shows a realistic 3D representation of a specific member or of the
optimised layout of a specific board.

Access
To open the 3D Model window, do the following:

1. Right-click a member in the Member List or Optimised tab.
2. Select 3D Model... from the context menu.

Note: If opened from the Member List tab, the 3D Model window will show a rep-
resentation of the selected member only. If opened from the Optimised tab, the full
composition of the board or stack formation containing the selected member will be
shown.

3D Model 83



Legend
The following elements can be present on the 3D model:

Board footprint (grey outline) Fenceline

Member (light brown) Non-shared regular cut (red plane)

Offcut (green) Shared cut (green plane)

Reuse (blue) Special cut (purple plane)
(e.g. half cut, sever cut)

Notes:
l The board footprint is only visible when opening the 3D model from the
Optimised tab.

l you can show or hide the fenceline and cutting planes by using the checkboxes
in the lower left corner of the window.

Controls

Hold down the right-click button and move the mouse to rotate the
model.

Click to jump to the previous member end.

Click to jump to the next member end.

 or  Press the left arrow key on the keyboard or click this button to
move the camera one step to the left.

 or  Press the right arrow key on the keyboard or click this button to
move the camera one step to the right.

Software Guide



 or  Scroll up with the mouse wheel or click this button to move the
camera closer to the board.

 or  Scroll down with the mouse wheel or click this button to move the
camera farther from the board.

Click to switch to the side view.

Click to switch to the top view.

USER MANAGEMENT

Note: This feature is available to Supervisor and Engineer access levels only.

Multiple users can be registered on the saw. Each user can have their own account
secured by a password and be assigned a specific User Access Level (see page 87). Addi-
tionally, user accounts can be useful to monitor the production levels of specific individuals
operating the saw (see User Summaries on page 91).
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To open the User Management window, select User Management... from the Tools drop-
down menu in the Simple menu bar.

Add/Edit a user

To add a new user or change the details of an existing user, do the following:

1. In the User Management window, select the user you wish to edit (if applicable).

2. Click or as appropriate.
The above window pops up.

3. Enter or edit the user's details.

Notes:
l The password is case-sensitive.
l The password fields are greyed out if the access level of the user is below
the password level set in the User Management window (see page 88).

l For more details about the Access Level field, see User Access Levels on
the facing page.

4. You can check Set as Default user if you want this user to be logged in auto-
matically when Simple starts.
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Notes:
l The default user will be logged in automatically without a password
prompt. Therefore, this option is not recommended for users with high
access level (Supervisor or Engineer).

l If no user is set as default, a manual login (see page 7) will be required to
operate the saw.

5. Click .

User Access Control
User access control enables plant management to restrict certain personnel from access-
ing some advanced features and altering system settings.

User Access Levels
Each user can be assigned one of the three access levels defined below:

Operator Supervisor Engineer

Options

Printer Setup

Plate Marking Control Panel

Batch Optimisation

User Management

Length Calibration

Setup

Everything else

 full access  limited access  no access

User AccessControl 87

https://help.vekta.com.au/Standard_V5_V11/Content/A_Operation/Length Calibration.htm


Change the access level of a user
To change the access level of a user, do the following:

1. In the User Management window, select the user you wish to change the access
level of.

2. Click .
3. Select the new access level from the drop-down list.

4. Click .

Password Level
The Password Level feature makes it possible to disable the password protection for the
users below a certain access level. This setting can be changed in the Password Level field
at the bottom of the User Management window.

E X A M P L E

By default, password protection is enabled for all access levels (Password Level is
set to Operator). If you want to enable the password protection for the users with a
supervisor or engineer access level but not with an operator access level, select
Supervisor from the Password Level drop-down list.

Remove a user
To remove a user, do the following:

1. In the User Management window, select the user you wish to remove.

2. Click .

3. Click in the confirmation window.
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Change the logged-in user's password

The password of the currently logged-in user can be easily changed in the Change Pass-
word window. To open the Change Password window, select Change Password... from the
Tools drop-down menu in the Simple menu bar.

Note: This feature is greyed out if the access level of the currently logged-in user is
below the password level set in the User Management window. For more details,
see Password Level on the previous page, User Access Levels on page 87 and
Change the access level of a user on the previous page.

PRODUCTION STATISTICS
Simple provides plant management with three means of monitoring production. The soft-
ware produces daily reports, monthly reports and user summaries.

Statistics webpage
The web-based Statistics page displays graphs about your saw's uptime and cut history,
and contains convenient links to the daily and monthly report spreadsheets.

To go to the Statistics webpage, select Statistics... from the Tools drop-down menu in the
Simple menu bar.

Alternatively, you can enter "localhost:8889/stats" in the address bar of your local browser.
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Notes:
l The webserver can be accessed remotely by replacing "localhost" with the IP
address or local hostname of the machine that runs Simple. Your network and
firewall configuration may need to be adjusted to allow remote access.

l The webserver port (8889 by default) can be changed in the General tab of the
Options window (see page 38).

Daily Reports
The daily reports provide an overview of the production levels achieved on the saw. They
are particularly useful for monitoring downtimes and the number of pieces cut on a par-
ticular day.

The daily reports are written in the file named "Statistics.xls". A daily report is added to
this file every day the saw operates. The file contains a line for each daily report.

Each line consists of the following fields from left to right:

DATE: date the line of data relates to
MEMBERS CUT: number of members cut in the day
OFFCUT BLOCKS: number of offcut blocks cut in the day
OFFCUT WEDGES: number of offcut wedges cut in the day
LENGTH CONSUMED (in metres): length of material consumed in the day
LENGTH PRODUCED MEMBERS (in metres): length of material used in the day to
produce members
LENGTH PRODUCED OFFCUTS (in metres): length of material used in the day to
produce offcuts
WASTE: percentage of non-reusable waste out of the total amount of material con-
sumed in the day
OPERATING TIME: amount of time in the day that the saw was in production, accord-
ing to the Maximum Command Execution Time defined in the Statistics tab of the
Options window (see page 50)
SHIFT CAPACITY: number of pieces (including offcuts) that could have been cut in
eight hours of operating time

Note: the shift capacity can be used to predict how the saw is performing
from day to day and to assess the potential benefit of changes made to the
optimisation settings or setup variables.

Monthly Reports
The monthly reports contain detailed production data collected regularly throughout the
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day. They are particularly useful for monitoring production trends over the course of the
day, week or even month.

The monthly reports are named after the month they pertain to (e.g. "May 2022.xls"). A new
file is automatically created at the beginning of each month. A new line is added to the file
at a regular time interval, according to the Monthly Statistics Interval defined in the Statistics
tab of the Options window (see page 50).

Each line consists of the following fields from left to right:

DAY: day of the week the line of data relates to
DATE: day number of the month the line of data relates to
TIME: end time of the interval the line of data relates to
MEMBERS CUT: number of members cut in the time interval
OFFCUT BLOCKS: number of offcut blocks cut in the time interval
OFFCUT WEDGES: number of offcut wedges cut in the time interval
LENGTH PRODUCED (in metres): length of the pieces (including offcuts) cut in the
time interval
MATERIAL CONSUMED: number of timbers consumed in the time interval
LENGTH CONSUMED (in metres): length of material consumed in the time interval
COST CONSUMED: cost of the material consumed in the time interval
OPERATING TIME (in minutes): amount of time in the time interval that the saw was
in production, according to the Maximum Command Execution Time defined in the
Statistics tab of the Options window (see page 50)
USER: name of the user who was logged in at that time.

User Summaries
The user summaries provide an overview of the production levels achieved by a particular
user.

The user summaries are written in the file named "Users.txt" located in the C:\Simple\
folder by default. The file contains a line for each user currently registered.

Each line consists of the following tab-delimited fields from left to right:

USER: name of the user the line of data relates to
ACCESS LEVEL: access level assigned to the user (0=Operator, 1=Supervisor and
2=Engineer)
For more details, see User Access Levels on page 87.
MEMBERS CUT: number of members cut by the user to date
OFFCUT BLOCKS: number of offcut blocks cut by the user to date
OFFCUT WEDGES: number of offcut wedges cut by the user to date
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ADVANCED FEATURES

Setup

Note: This feature is available to Engineer access level only.

The Setup window is used to modify advanced variables.

To open the Setup window, click on the Control Bar (see page 30).

CAUTION
Modifying advanced variables may have serious and adverse effects on the
performance of the saw.

Click any row to have additional information about the corresponding variable.

The variables' values are automatically read in when Simple is started. To refresh these
values, click .
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To modify a variable, do the following:

1. Click the editable field in the Value column.

Note: the greyed out fields are not editable.

2. Enter a value comprised between the Min and Max allowed values.
3. Press the Enter key.

A confirmation window pops up.
4. Click .

The change is in effect until the machine is powered down.

Note: when the machine is powered down, any unsaved changes will be lost and
the variables will be reset to their last saved values.

To permanently save the changes, click  .

Diagnostics
The Diagnostics window gives detailed information about the current status of the machine
and any errors that may be present.

Most errors will automatically force this window to pop up. Otherwise it can be accessed by

clicking on the Control Bar (see page 30).

If an error is present, the corresponding status box in the top matrix will show in red or yel-
low. The lower matrix represents each axis motor status indicated with the axis name on
the horizontal title bar and the status name on the vertical title bar.
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A red box indicates a fault condition.
The saw is completely stopped. Attention is required before resuming operation.

A yellow box indicates a warning condition.
The operation is suspended. In most cases, operation can be resumed by pressing
the green START button on the operator console.

For a quick description of the error, hover over the box to display a tooltip. Click the box to
show a pop-up with further information about the error.

Note: all other information is not used or obsolete.

Kickoff Rule Syntax
Kickoff rules are comparisons that define specific members in order to send them to a par-
ticular kickoff location.

E X A M P L E
The following rule sends all webs to station 5.
Rule Location
type = web 5

The following rule sends all members longer than 1 m to station 2.
Rule Location
length > 1000 2

The following logical operators are supported:
= (or ==) equal

!= not equal
< less than
<= less than or equal to
> greater than
>= greater than or equal to
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A rule may have multiple conditions. All conditions must be met for the rule to apply. Condi-
tions are separated by an ampersand (&).

E X A M P L E
The following rule sends all webs longer than 1 m to station 7.
Rule Location
type = web & length > 1000 7

A rule with no condition is always true (i.e. any member is sent to the specified location).

E X A M P L E
The following rule sends any member to station 3.
Rule Location

3

If multiple rules are specified, the first rule to have its conditions met is applied (starting
from the top of the list and moving down).

The following fields are supported:

Member Field Value Type Description
name text name of the member (job:truss:member)
job text designation of the job the member belongs to
truss text designation of the truss the member is part of
member text designation of the member within the truss
material text description of the material assigned to the member
type text type of the member (e.g. web)
width number width of the member (in mm)
thickness number thickness of the member (in mm)

length number overall length of the member including any automatic
length adjustment (in mm)

boardlength number length of the board used to cut the member (in mm)

nominallength number overall length of the member as it appears in the job
file (in mm)

number number member number out of the total quantity of the same
member (e.g. 3 for member 3 of 6)

totalnumber number total number of the same member to be cut (e.g. 6 for a
member cut 6 times)
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Member Field Value Type Description

done flag true or false depending on whether the member has
already been cut

binnumber number
number of the bunk the board was taken from to cut
the member (if an automated timber retrieval system is
installed)

trussordernumber number order number of the truss as it appears in the job file
numcuts number number of cuts on the member
invalidcuts number number of invalid cuts on the member

The fields below are applicable to Omni XML job files only.

nextstation text NextStation value for the member as it appears in the
job file

side text Side value for the member as it appears in the job file

aoside text AOSide value for the member as it appears in the job
file

trusslength number length of the truss (in mm)

Note: field names and values are case-insensitive.

Automatic Length Adjustment
The Automatic Length Adjustment is a feature that makes it possible to automatically
lengthen or shorten some members, depending on their type and nominal length, to suit
your plant's particular needs.

When an automatic length adjustment has been applied to a member, the new length is
indicated in red. The nominal length is indicated in parentheses on the Member Diagram
(see page 28).

Note: to set up or change the Automatic Length Adjustment on your saw, please
contact Vekta Automation.

Software Guide



SIMPLE CHANGELOG

Version 14
l Bugfixes
l Print multiple images / texts
l Printer markings
l Print Kickoff location
l Picklist interface
l Sort by build order
l Exclude material grades from offcut
l Board tracker
l Board tracking status
l Volume statistics in daily and monthly reports

Version 13
l Bugfixes
l Auto save files
l Auto archive files
l Manually mark job as complete
l Nail plate orientation marks
l Panel numbers on trenched plates
l Member Designation Labels window
l Saw blade indicator
l Stak'n'Gap integration
l Packfeeder 2 integration
l Export materials list to CSV or TXT files
l Workday uptime percentage statistic

Version 12
l Bugfixes
l Auto load/close files
l Web notifications
l Remote view & interaction
l Ply bracing marking (shaded area)
l Picklist (web view)
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l Files associations (double-click to open)
l Telemetry server
l Vekta Rescue auto config update

Version 11
l Bugfixes
l Overhang marking
l Raise and clear error codes from dev console
l Customisable member flipping priorities
l Truss boot marking
l Jack truss intersection marking (public)
l Machine Name, Site Name & Vekta ID introduced
l Machine Name on picklist
l Raking Stud member designation
l Bundle numbers
l Statistics webpage
l Reuse docking
l Waste column in optimised list

Version 10
l Bugfixes
l Kickoff Selection
l Mid-stick resume
l Jack truss intersection marking (for Placemakers only)
l 3D preview
l Bevel cut orientation
l Interleaved file merge
l Uptime display on control bar
l Column selection
l Truss order number
l New markings
l Flip members
l Linear Pick Line support

Version 9
l Bugfixes
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l Error Code reporting
l Mitre stacking
l New user management system
l Snapshots (triggered by error code)

Version 8
l Bugfixes
l Print company name on top
l Filter company name by material type
l Open File Location
l Supports different member shapes with the same name
l Omni XML (aka Blade XML) file support
l WoodRunner interface
l Help system (online only)
l Batch optimisation
l Pre & Post Stacking
l Program grids hidden by default
l Job Sequencing

Version 7
l Bugfixes
l Print company name BMP (side only)
l Undercuts
l Tabbed documents
l Activation UI
l Moved tick boxes to toolbar (easier control)
l Auto Length Adjustment
l Run Simple from an arbitrary directory (e.g. from a thumb drive)
l Save selected members into separate file
l Stacking support for Packfeeder
l "Optimise" button changed to "Optimise Uncut"
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